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Revisions-Geschichte

Date Version Comments

02-04-2020
22-04-202

1.0
1.1

Erste Version der Dokumentation.
Lizenz-Indexseite hinzugefügt und neue Videolinks
hinzugefügt

1.
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Objektiv
Dieses Dokument enthält eine umfassende Auflistung und Erläuterung der Funktionen der
PrintFactory-Desktop-Software, die dem Händler als Nachschlagewerk für Schulungszwecke,
Installationsanleitungen und häufige Fragen von Kunden dienen soll.

Es enthält Links zu einigen der im Hilfecenter verfügbaren Anleitungen.

Das Dokument ist in 7 Hauptthemen unterteilt:

● Software Manager - Lizenz Management
● RIP
● Layout
● Calibrator
● Editor
● PrintStation
● Cloud
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Nützliche Informationen und Links

PrintFactory app
https://app.printfactory.cloud/home/index

Help center
https://help.printfactory.cloud/knowledge-base/

How-to Videos
https://help.printfactory.cloud/how-to-videos/

Support mails
support@printfactory.cloud

DealerZone

https://dealer.printfactory.cloud/

Verkaufsregeln und -bedingungen (bitte beachten Sie, dass diese häufig aktualisiert werden)

https://dealer.printfactory.cloud/rules-and-conditions-of-sale/

PrintFactory page 4 of 21

https://app.printfactory.cloud/home/index
https://help.printfactory.cloud/knowledge-base/
https://help.printfactory.cloud/how-to-videos/
mailto:support@printfactory.cloud
https://dealer.printfactory.cloud/
https://dealer.printfactory.cloud/rules-and-conditions-of-sale/


Lizenz Management
Die Lizenzverwaltung erklärt, wie der Lizenzserver im Zusammenhang mit den
PrintFactory-Modulen arbeitet und wie er mit der Cloud kommuniziert. Dieses Kapitel behandelt
auch den Prozess der Lizenzerstellung, Registrierung, Installation und Aktivierung.

Concept:
Wenn eine Lizenz erstellt wird, wird ein Konto in der Cloud generiert. Von diesem Cloud-Konto
aus wird die Lizenz verwaltet: ihre Erstellung und ihr Ablauf, die SUC-Validierung und die
verfügbaren Treiber. Daher ist es wichtig, dass der Lizenzserver eine offene Kommunikation mit
der Cloud über app.printfactory.cloud hat.

Nur der Lizenzserver benötigt einen Internetzugang. Die verschiedenen anderen Module von PF:
RIP, Editor, Layout, Kalibrator und PrintStation sind lokal zugänglich und erfordern nur den Zugriff
auf den Lizenzserver-PC.

❏ Types von Lizenzen, die zum Kauf oder zur Miete erhältlich sind, und die
Vergleichsmatrix zeigt, welche Funktionen in welchem Plan enthalten sind.
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❏ Erstellen und Registrieren einer Lizenz
❏ https://app.printfactory.cloud/order/index

❏ Händler und Preisliste auswählen => neue Lizenz
❏ Treiber auswählen, den Führerschein planen und registrieren

❏ Online installieren und aktivieren
❏ Wie:

https://help.printfactory.cloud/knowledge-base/license-registration-and-online-ac
tivation/

❏ Wichtig zu beachten: System- und Infrastrukturüberlegungen
❏ https://help.printfactory.cloud/knowledge-base/system-requirements-v
❏ https://help.printfactory.cloud/knowledge-base/infrastructure-consideratio

ns-v1/

❏ Version herunterladen : https://app.printfactory.cloud/home/index
❏ Unterstützung -> Downloads => Neueste Version herunterladen und

Installationsprogramm ausführen
❏ => 5 Anwendungen sind installiert und der Software Manager öffnet sich

❏ Software Manager
Was: Verfolgt Software-Updates, Lizenzierung, Treibertausch und Ressourcenmanagement.
Der Software Manager ist eng in den Lizenzserver integriert, der die Kommunikation mit
der Cloud übernimmt.

❏ 5 Registerkarten oben
1. Help site
2. Cloud Konnektivität:

a. zeigt die Verbindung zum Lizenzserver, die IP des Lizenzserver-PCs
und die Kommunikation zwischen Lizenzserver und Cloud. Wenn
Sie mit der Maus über die Ticks fahren, werden die
Comms-Informationen hervorgehoben.

b. Seriennummer der Lizenz
c. wenn das Abonnement abläuft
d. welcher Aufbau auf diesem PC installiert ist

3. Lizenz-Konfiguration
a. Art der Lizenz und wie viele Lizenzen für jede Anwendung
b. Aufgeführte Treiber dieser Lizenz: wenn im RIP geladen -> zeigt

die IP des PCs an, auf dem der Treiber läuft

4. Aktualisierungen der Lizenz
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a. Der Auto-Updater wird auf den vor der letzten Veröffentlichung
eingestellten Version gesetzt.

b. Zeigt alle verfügbaren gespeicherten Profile für die geladenen
Treiber zum Herunterladen

5. Ressourcen
a. Liste aller Ressourcen - standardmäßig und benutzerdefiniert

erstellt - die in der Lizenz verfügbar sind und über die CLoude
freigegeben werden:

i. Farbprofile (pmms, icc)
ii. Job-Etiketten
iii. Fotoba presets
iv. Im Editor erstellte Vorlagen

❏ Seite Lizenz-Index auf app.printfactory.cloud -> Registerkarte Partner -> Übersicht ->
Lizenz-Seriennummer eingeben
Stellt alle Informationen und die Geschichte einer Lizenz zur Verfügung:
❏ Plan, Kauf- oder Mietdatum, Ablauf der SUC, Aktivierungsstatus
❏ In der Lizenz verfügbare Treiber
❏ Aktuelle installierte Version und Versionsgeschichte
❏ Hardware-Informationen des Lizenzservers
❏ Lizenz-Aktivitätsprotokoll (getauschte Fahrer, Aufträge, Ablauf,...)

Diese Lizenz-Indexseite wird auch verwendet, um einen Treiber aus der Lizenz
hinzuzufügen, zu löschen oder zu tauschen oder um ihn zwischen Lizenzen derselben
Organisation zu verschieben.
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RIP
RIP ist die Verarbeitungs-Engine von PrintFactory. Der RIP verarbeitet die Druckdateien und
kommuniziert mit den Druckgeräten. Das RIP ist eng mit dem Lizenzserver verbunden und
validiert die Lizenz und die verfügbaren Treiber und interagiert mit der Cloud bezüglich der
Sicherung der Ressourcen.

❏ Laden von Treibern [File -> Output Device -> New]
❏ Output/ Verbindungsoptionen, die je nach Druckertreiber variieren: TCP/IP,

Anschluss, Ordner, PrintStation
❏ Registerkarte "Option

❏ Gleichzeitige Jobs: Anzahl der gleichzeitig gerippten Jobs.
❏ Bild-Cache-Größe: Speichermenge, die maximal für das

Zwischenspeichern von Bilddaten zum Rippen des Auftrags verwendet
wird: nur bei hoch spezifizierten PCs von der Standardeinstellung zu
erhöhen.

❏ Bandbreite: Speichermenge, die maximal für die Darstellung eines Bandes
verwendet werden kann. Es ist nur ratsam, bei hochspezifischen Stücken
von der Standardeinstellung zu erhöhen.

❏ RIP Benutzeroberfläche und Präferenzen
❏ Hauptlayout mit schwebenden Fenstern: [View -> device status, preview, system

load]
❏ Cloud comms:

❏ [Bottom right of RIP window]:grüner Punkt: Cloud comms OK. Es ist
wichtig, dass die Kommunikation mit der Cloud funktioniert und dass
Nachrichten an oder von der Cloud nicht blockiert werden.

❏ Cloud UP: Nachrichten an die Cloud. Diese variieren von
Ressourcen-Uploads bis hin zu Jobs, die Benachrichtigungen und
Fehlermeldungen verarbeiten.

❏ Cloud DOWN: Nachrichten, die aus der Cloud kommen: z.B. gemeinsame
Nutzung von Ressourcen: z.B. Profile/Label/Vorlagen, die auf anderen RIPs
erstellt wurden.

❏ RIP Benutzeroberfläche:
❏ Anpassbares Ansichtsfenster von Jobs (Hinzufügen, Entfernen und Ziehen,

um die Reihenfolge zu ändern) und Symbolleiste: Hinzufügen und
Entfernen.

❏ Schriften importieren
❏ WorkFolder: Standard-Speicherort auf c:\\users\shared (oder öffentlich auf

Win)\PF\Work: enthält die Daten der im RIP angezeigten Jobs.
❏ RIP-Bereinigung: löscht die im RIP angezeigten Jobs.
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❏ PDF Job Cleanup = Kann den Auftrag nicht bearbeiten, nur derselbe
Auftrag kann wieder an den Drucker gesendet werden.

❏ Print Job Cleanup = Auftrag kann im Layout/Editor bearbeitet werden. Der
Auftrag muss erneut gerippt werden, um ihn erneut an den Drucker zu
senden.

❏ Job-Informationen [Rechtsklick Job]
❏ Job hinzufügen: öffnet eine neue Instanz von Layout
❏ Relaunch von Aufträgen über Layout oder Editor

❏ Inspector:
❏ Druckdatei: zeigt genau die Druckausgabe (Softproof), Tintenzerlegung

und TAC
❏ Schnittdatei: zeigt das Schneidewerkzeug und die Schnittfolge: Ansicht ->

Schneiden simulieren.

❏ Auftrag starten: sendet die Datei an den Drucker
❏ Job-Info: Farbe und Ref. Profil-Info, Schmuckfarben-Info, Job-Layout
❏ Backup-Job: enthält pmm- und Job-Einstellungsinformationen für den Fall einer

Support-Anfrage.

❏ Sichern und Wiederherstellen:
❏ [Bearbeiten -> Backup-Einstellungen]: sichert alle Treiber und Warteschlangen des

RIPs - nicht die Jobs
❏ Bearbeiten -> Drucker sichern]: sichert den Drucker mit seinen Warteschlangen.
❏ [Bearbeiten -> Einstellungen wiederherstellen]: stellt beides wieder her:

❏ den Sicherungsauftrag im RIP mit allen Einstellungen
❏ der Sicherungsdrucker mit seinen Ausgabeeinstellungen und

Warteschlangen
❏ die Einstellungen: alle Drucker und Warteschlangen.

❏ Medieneinstellungen und -größen:
❏ Größen [Datei -> Ausgabegerät -> Mediengrößen bearbeiten]: generisch aus dem

Treiber und benutzerdefinierte Größen, die hinzugefügt werden können. Alle
Mediengrößen werden dann im Layout angezeigt.

❏ Media Settings File -> Output Device -> Change media]: Einstellung des
geladenen Mediums: bestimmte Treiber ziehen diese Informationen vom Drucker.
Wenn nicht, kann sie auf Any gesetzt werden, um Medienkonflikte zu vermeiden.

❏ Job-Etikett generieren [File -> Generate Job Label]
❏ Geben Sie einen Namen ein und wählen Sie Informationen für das Etikett aus.

Starten Sie dann RIP und Layout neu, damit das neu erstellte Etikett unter Layout
-> Bildmarken -> Job-Label erscheint.

❏ Certify a Job: [right click job with measurement strip -> certify job]
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❏ Zertifizieren Sie einen Auftrag: dann wird ein z.B. Fogra-Streifen mit dem Auftrag
gedruckt.

Automatisierung im RIP

❏ Erstellen einer Warteschlange
❏ Erstellen einer Schachtelung mit bedingten Auslösern
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Layout
Layout ist ein intuitives Auftragsvorbereitungsmodul: Erstellung einer druckfertigen
verschachtelten Datei, mit Werkzeugen für die Weißerzeugung und den Zuschnit,
Nachbearbeitung und Optionen für eine einfache doppelseitige Dateierzeugung.

❏ Beim Öffnen des Layouts werden die Dateien zum Laden aufgefordert. Wenn keine pmms
verfügbar sind, bleibt es: 'Drucker suchen'.

❏ Allgemeine UI und Präferenzen:
❏ [View]: Möglichkeit, nur relevante Fenster zu öffnen. Alle Fenster sind schwebend

und können zur Anpassung der Benutzeroberfläche (UI) in den linken oder rechten
Rand gezogen werden.

❏ Präferenzen:
❏ Fester Lizenzserver: Wenn mehrere Lizenzen unter demselben Netzwerk

liegen, wird Layout alle Drucker aus allen Lizenzen aufnehmen. Um dies
einzuschränken, stellen Sie die IP des Lizenzserver-PCs ein, für den Sie nur
die Treiber sehen möchten.

❏ Feste RIP-IP: zeigt nur die Treiber an, die auf RIPs mit den aufgelisteten
IPs geladen sind.

❏ Optionen zum Absenden von Daten.
❏ Referenzprofil- und Eingabefarbeinstellungen: Wenn das Referenzprofil

hier eingestellt ist, wird es beim Öffnen von Layout als Standard
angezeigt.

❏ Jobname und Kopien

❏ Einführung in das Layout: Jobs, Medien- und Pmm-Einstellungen, Job-Einreichung

- Layout Intro1: Pmm, Referenzprofil und Mediengröße

- Layout Intro2: Laden von Jobs, Drehen, Skalieren, Spiegeln und Beschneiden

❏ Dateien laden: [Job window -> +] or [File -> add files]
❏ Wählen Sie Skalieren, Drehen, Kopien einstellen, auf die Seite anpassen, auch

beschneiden
❏ Leinwand auswählen:

❏ [Top left]: Mediengrößen des ausgewählten Druckers und alle im RIP
hinzugefügten Medien

❏ Ränder: Kann auf jede Seite angewendet werden
❏ Farbbalken: Kann angehakt und eine benutzerdefinierte Größe

angewendet werden.

❏ zieht die geladenen Medien aus dem RIP.
❏ Pmm und Referenz Profilel

PrintFactory page 11 of 21

https://help.printfactory.cloud/knowledge-base/layout-submit-behaviour/
https://help.printfactory.cloud/knowledge-base/layout-regex/
https://help.printfactory.cloud/knowledge-base/layout-job-copies/
https://help.printfactory.cloud/knowledge-base/layout-size-crop/


❏ Optionen zum Absenden von Daten:
❏ Kopien: Die Druckdatei wird einmal verarbeitet, sendet die Datei aber

mehrmals an den Drucker.
❏ Prioritäten für die Einsendung von Dateien:

❏ Normal: als nächstes hinzugefügte Aufträge in der Reihe
❏ Expedite: der Job ist der nächste in der Reihe
❏ Hold: der Auftrag wird verarbeitet, aber nicht an den Drucker

gesendet
❏ Jobname: kann manuell geändert werden und ist beim Laden von Jobs

standardmäßig der Name des ersten Jobs im Jobfenster.

❏ Ausrichtung und Schachteln von Objekten

❏ Bildabstand im Vergleich zur Stoßfuge
❏ Nesting and true shape nesting (Verschachtelung und formgerechte

Verschachtelung)

❏ Gruppierung: [select few images -> Edit -> Group]
❏ Bildmarken:

❏ Bildmarken - bleed

❏ Bildmarken - Rand

❏ Bildmarken - Label

❏ Bildmarken - Tiling

❏ Zertifizierungsstreifen / Job-Info / benutzerdefinierte Job-Etiketten:
Positionierungsoptionen

❏ Rand: Optionen für Voll-, Strich- oder Schnittmarken in festgelegtem Abstand vom
Bild. ( Der eingestellte Abstand erlaubt auch das Hinzufügen von Markierungen in
diesem Bereich.)

❏ Endbearbeitungswerkzeug
❏ Ösen, Falz, Beschnitt und Basis fliesen. Für komplexe Tiling bietet der Editor

zusätzliche Funktionalitäten: z.B. Vorlagen für verschiedene Medien (z.B.
Autovinyl: Fenster vs. Karosserie).)

❏ Schneiden:
❏ Feed: Position des Schneidkopfes nach der Bearbeitung des Auftrags (falls vom

Gerät unterstützt). Der Transport bezieht sich auf Flachbettschneider, die in der
Lage sind, die Medien vom Tisch zu bewegen.

❏ Sortieren: Methode zum Sortieren der Konturen, um die effizienteste Bewegung
des Schneidekopfes ("Geschwindigkeit") oder die minimale Menge an
Medienvorschub zu erhalten, um Registrierungsprobleme zu vermeiden
("Transport").
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❏ Markierungsmodul: Seit V6.3 können Kunden ihre Registrierungsmarken,
Strichcodes und Etiketten in Bezug auf Größe, Positionierung, Anzahl und Typen
anpassen.

❏ Werkzeuge für die Zuordnung von Punkt zu Schnitt
❏ Abfalloptimierung: definiert die Größe, auf die der Abfall reduziert werden kann,

so dass der Abfall von großen Blättern reduziert werden kann.

❏ Drucker-Einstellungen:
❏ Treibereinstellungen des gewählten pmm: einige Einstellungen können je nach

Treiber geändert werden: z.B. Schneiden nach dem Druck

❏ Textilschritt und Wiederholung
❏ Einrichten von Dekoren mit verschiedenen Rapportmustern und unterschiedlichen

Größen auf derselben Fläche

❏ Weiße Generation
❏ Datei mit und ohne weiße Ebene

❏ Doppelseitig.

❏ Doppelseitig
❏ Doppelseitig mit mehrseitigem PDF

❏ Drehen: auf die B-Seite durch Drehen des Blattes von links nach rechts
❏ Sturz: auf die B-Seite, indem das Blatt von oben nach unten gewendet wird
❏ Die Dichte kann für transparente Medien eingestellt werden
❏ Mit Submit werden die A- und B-Datei sofort generiert.
❏ Manuell Doppelseitig: Gleiches Bild auf beiden Seiten oder Ziehen des Bildes auf

die B-Seite.
❏ Automatische Erstellung der B-Seite mit mehrseitigem PDF, wobei ungerade

Seiten = A-Seite und gerade Seiten = B-Seite

❏ Layout speichern
❏ Speichern Sie die Lagenpositionen als Platzhalter und ermöglichen Sie, dass neue

Bilder auf die gespeicherte Vorlage gezogen werden können.

❏ Kompensation der Mediengröße:
❏ Erhältlich für 1 Seite oder beide Seiten. Gespeichert und jedes Mal angewendet,

wenn beim Senden von Dateien an RIP der pmm-Wert ausgewählt wird.
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Calibrator
Kalibrator ist das Farbmanagementmodul zur Erstellung und Pflege von Farbprofilen, zur
Abstimmung von Device Link und zur Definition und Abstimmung von Sonderfarben

❏ Zeigt alle im RIP geladenen Drucker an
❏ Präferenzen

❏ Feste Server-IP: erlaubt die Anzeige nur der Druckerprofile der ausgewählten
PC-IP

❏ Messgeräte-Einstellungen: unterstützte SpectroPhotometer und Einstellungen:
❏ Spectro kann hier oder bei der Erstellung des pmm ausgewählt werden.
❏ Measuring mode settings: M0, 1, 2 ,3

Profilerstellung und Instandhaltung.

❏ VISU profiles - Device Link ICC - .pmm: Printer, media, mode
❏ Erstellen Sie ein VISU pmm (Printer - Media - Mode)

❏ Show case: Messdaten für CMYK- und CMYKcm-Profile
❏ Treibereinstellungen und Bedeutung der Auswahl der richtigen

Medienvoreinstellungen
❏ Tinteneinstellungen -> Tintenarten zusätzlicher Farben

❏ Normal = wirkt als erweitertes Gamut/Mehrkanalprofil (d.h.
CMYKOGV).

❏ Spezial = bezieht sich auf technische Druckfarben wie Weiß oder
Lack.

❏ Spot = kann als zusätzlicher Kanal im Editor verwendet werden
(z.B. um einen Kanal für die reine Ausgabe (wie Grün, Orange usw.)
abzubilden)

❏ Einschluss weißer Tinte:
❏ Weiß-Linearisierung: wenn weiße Farbverläufe erforderlich sind
❏ Standardmäßige lineare Kurve für: Flut, (inverse) Dichte, unter

Farbe.
❏ Profil-Varianten

❏ Default
❏ Custom for VISU: in besonderen Fällen die K-Generation und Reinigung zu

ändern.
❏ Re-Kalibrierung: um es wieder in den genehmigten, ursprünglichen Zustand zu

bringen
❏ Duplizierung eines pmm: im Falle von Änderungen an einem pmm, möchten aber

den ursprünglichen pmm beibehalten.
❏ Import and Export pmms

❏ Profil-Konvertierung zu VISU:
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❏ Welche Profile?
❏ Automatisch heruntergeladenes HP ICC-Profil: Zu VISU konvertieren
❏ Importierte .EMX-Profile für Epson-Geräte -> nach VISU konvertieren

❏ Warum?
❏ Besseres neutrales Grau
❏ Reinere Schmuckfarben
❏ Eco-Save-Option

❏ Device link Tuning:
❏ INFO: Device Link profiling: direkte CMYK-zu-CMYK-Konvertierung. Bei

VISU wird die Device Link beim ersten Rippen des Bildes erstellt -> das
Referenzprofil wird in der Variante gespeichert.

❏ Die Device link optimiert die Konvertierung von der Referenz in das PMM
und macht sie präziser, die nur in Proofing-Szenarien verwendet wird.

❏ Light Adaptation Tool (LAT)
❏ Was und warum?: Manuelles "Pick-a-Winner"-Tool, das die Graubalance des Pmm

verschiebt, um verschiedene Beobachtungslichter zu berücksichtigen. Wenn das
Beobachtungslicht bekannt ist und sich konsistent vom Standard-D50
unterscheidet, kann es in den erweiterten pmm-Einstellungen eingestellt werden.

❏ Dot gain correction
❏ Was? Werkzeug zur Verschiebung der Farbbalance im pmm.
❏ Warum? Schnell, vor Ort, manuell, Änderungen am Profil - eher außerhalb des

Farbprofilierungs- und Rekalibrierungsprozesses.

Sonderfarben

❏ [Mode window of pmm -> select Spot colors -> right window: Spot colors]
❏ Hinzufügen einer Sonderfarbe : entweder durch Messung oder Eingabe von

Werten in Lab oder CMYK

❏ Drucken Sie die Farbbücher für die ausgewählten pmm aus
❏ Schmuckfarben-Bibliothek :

❏ Hinzufügen und Exportieren einer Bibliothek
❏ Zeigt das Delta E dieses Spots mit dem gewählten PMM

❏ Tune a spot color, Spot-Farbabstimmung: erlaubt das Ändern: :
❏ entweder in Lab oder LCh
❏ Anzahl der Patches
❏ Schrittgröße auf jeder Achse (Lab oder LCh)
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❏ Spot color purification Reinigung von Sonderfarben durch Manipulation von:
❏ Schwarzer Start
❏ Schwarzer Max

PrintFactory page 16 of 21

https://help.printfactory.cloud/knowledge-base/visu-clean-spot-colours-improved-handling/
https://help.printfactory.cloud/knowledge-base/calibrator-spot-libraries-and-purify/


Editor
Der Editor ist das Bearbeitungsmodul. Es enthält häufig verwendete Werkzeuge zur Bearbeitung
und Korrektur von Dateien. Der Editor wird z.B. für das Soft-Proofing der Druckvorlage, das
Farbmanagement, die Verwaltung der Dateiebenen, das Hinzufügen von
Nachbearbeitungsanforderungen, das Tiling, die Weißerzeugung und die Erstellung von
Schnittkonturen verwendet.

❏ Benutzeroberfläche und Fenster.
❏ Dokumentgröße: ist die praktikable Bildgröße

a. Öffnen Sie ein neues Bild: die Dokumentgröße ist die Bildgröße
b. Ein neues Bild platzieren: Das Bild wird auf die eingestellte Dokumentgröße

zugeschnitten
c. Bearbeiten Sie die Dokumentgröße.

❏ Auswahl von Pmm und Schneider :
a. Sobald der Pmm und der Cutter ausgewählt sind, können diese beim Senden an

Layout nicht mehr im Layout geändert werden.
b. Speichern des Referenzprofil in einer Datei zur späteren Referenz.

❏ Senden von Dateien:
a. Wenn mehrere Dateien geöffnet werden, werden alle Dateien an Layout gesendet.
b. Senden von geschnittener Datei ohne Druckdaten

❏ Präferenzen:
a. Allgemein:

i. Feste RIP-IP: zur Begrenzung der RIPs und damit der Druckertreiber, die
der Editor sehen und an

ii. Feste IP des Incense-Servers: falls mehrere Lizenzen auf der gleichen
Website verwendet werden.

b. Erklärungen und Empfehlungen zu Standard und Farbe
i. Hinweis: Papierfärbung simulieren: nur für die Visualisierung auf dem

Bildschirm

c. Fehler: Ist das Pre-Flight-Modul
i. Enthält eine Auswahl häufig verwendeter Fehlerprüfungen und kann

angepasst werden, wobei die Verwendung beim Öffnen der Datei definiert
werden kann.

ii. Das schwebende Fenster kann über [Ansicht] -> [Fehler] aufgerufen
werden. Wenn ein Kriterium in der Datei als "Fehlgeschlagen" ausgewählt
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wird, zeigt die Auswahl der Pfeilfunktion an, auf welche Teile der Datei es
sich bezieht.

d. Standarddokumentgröße beim Öffnen des Editors
e. Shortcuts: Möglichkeit, die Standard-Shortcuts zu ändern
f. Schnittkonturen: häufig verwendete Konturen können gespeichert und so

eingestellt werden, dass die Karten beim Öffnen der Dateien angewendet werden.
g. Hochladen von speziellen Schriftarten.

❏ PDF Editing
a. Editing Hue and saturation levels
b. Text Editing

❏ Endbearbeitungswerkzeug
a. Show case: FinishingTool.pdf

1. Finishingtool.pdf öffnen
2. Schlichtwerkzeuge über die linke Symbolleiste öffnen
3. Fold, Bleed und Grommets auf allen Seiten hinzufügen.

Hinweis: Wenn Sie das Kontrollkästchen Auf alle Seiten anwenden aktivieren,
werden die Finishing-Einstellungen auf alle Seiten eines mehrseitigen Dokuments
angewendet.

❏ Tiling
a. Show case 1: Tiling5mx5m.pdf

1. Offener 5000mm x 5000mm Job
2. In 4 Spalten und 4 Reihen kacheln, um auf eine 54-Zoll-Rolle zu passen

mit
3. Bei Layout einreichen, um die einzelnen Kacheln in der Jobliste Layout

anzuzeigen.
Hinweis: Erklären Sie auch die Überlappung

b. Show case 2: VehicleWrap.aur
1) Show how Editor can be used to create tiling templates with vehicle wrap

templates

❏ Relabel-Option: tiles nach ihrer Erstellung neu etikettieren
❏ Option zurücksetzen: Tiles zurücksetzen
❏ Flip L/R H/V: Flip-Kacheln für z.B: Links und rechts von einem Auto
❏ Tiling report: [Datei]-> [Layout speichern] oder [Drucklayout]

❏ Weiße Generation
a. Show case: CookieswithWIT.aur
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1) CookieswithWIT.aur öffnen
2) Zuordnung von Wit-Spot zu Weiß-Kanal mit Extra-Menü
3) Verwenden Sie das Werkzeug "Weiß erzeugen", um der Datei zusätzliches

Weiß hinzuzufügen
4) Schalten Sie andere Kanäle aus und lassen Sie nur den weißen Kanal

stehen, um zu sehen, wo die weiße Tinte gedruckt wird.

❏ Templating

❏ Map spot color
a. Show case: SpotMap.pdf

1) Spotmap.pdf öffnen
2) Wählen Sie in der Farbliste aus: Neue Farbzuordnung und geben Sie den

Namen 'Demo' ein
3) Ziehen Sie PANTONE 144 auf den CMYK-Orange-Rahmen
4) Ziehen Sie PANTONE 2597 auf CMYK-Lila im Logo
5) Dokument schließen und wieder öffnen
6) Wählen Sie 'Demo'-Farbkarte aus dem Farblistenfenster

❏ Map spot to Cut Contour
a. Show case: PrintFactoryWobbler.pdf

1) PrintFactorywobbler.pdf öffnen
2) Wählen Sie PMM und Cutter.
3) In den Ausgabekanälen eine Schmuckfarbe namens 'CUT' anzeigen
4) Öffnen Sie das Werkzeug "Zu schneidende Kartenpunktfarbe" aus dem

Menü "Extra".
5) Zuordnung der 'CUT'-Schmuckfarbe zu einem Schnittwerkzeug, z.B.

kiss-cut
6) Zeigen 'CUT'-Sonderfarbe ist nicht mehr in den Ausgabekanälen, sondern

es gibt stattdessen eine neue Schnittebene im Ebenenfenster.

❏ Erstellen einer Cut Contour
a. Show case: PrintFactorySticker.pdf

1) PrintFactorySticker.pdf öffnen
2) Wählen Sie das Bild mit dem Auswahlwerkzeug
3) Wählen Sie in der linken Symbolleiste das Werkzeug Schneidepfade

erstellen
4) Klicken Sie auf die weiße Fläche im Dokument, um einen Schneidepfad

um den Aufkleber herum zu erstellen, klicken Sie auf Anwenden.
5) Bewegen Sie die Schnittlinie mit dem Werkzeug 'Outline' aus dem Menü

Extra nach innen.
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PrintStation
PrintStation ist eine 'Rip Once Outward Many'-Anwendung, die die gerippten Dateien zur
Verschachtelung sammelt, bevor sie an den Drucker gesendet werden.
Sie wird häufig für Drucker ohne DFE verwendet.

Ab V6.3.1 wird die Berichterstattung über Druckaufträge eingeführt, deshalb wird zuerst die
PrintStation eingerichtet, bevor der abgeleitete PrintStation-Treiber in das RIP geladen wird.

PrintStation überläßt auch die Caches und Medieneinstellungen von bestimmten Druckern (d.h.
HP-Treibern), ähnlich wie bei der Einrichtung über TCP/IP. Bei PrintStation werden die Caches im
Input-Ordner gespeichert.

❏ Wie man eine PrintStation einrichtet
❏ PrintStation-Eingabeeinstellungen
❏ Feste IP
❏ Aufräum-Einstellungen
❏ Room-Modus:

❏ Manuell - Dateien manuell an den Drucker senden.
❏ Auto - Dateien automatisch ohne Benutzereingabe senden.

❏ Mediengröße, Abstände und Ränder
❏ Treiber-Einstellungen
❏ Ziehen und Ablegen, Verschachtelung und Drehung

PrintFactory page 20 of 21



Cloud

http://app.printfactory.cloud

Die Cloud App bietet dem Kunden folgende Dienste an:

Dashboard
Das Dashboard zeigt einen Live-Status der Drucker aus dem RIP an: angeschlossene Geräte,
Anzahl der Aufträge, die auf die Verarbeitung warten.

Production Jobs
Auftragsinformationen mit Vorschau und RIP-Status.

Reporting
Das Standardberichtsmodul gibt Informationen für einen bestimmten Zeitraum zurück:

● Tintenverbrauch - basierend auf den von jedem Hersteller gelieferten
Tröpfcheninformationen.

● Mediennutzung und Effizienz
● Anzahl der Aufträge pro Gerät.
● Die Kostenberechnung für Tinte und Medien wird über die Einstellungen in

app.printfactory.cloud eingerichtet. -> Konto -> Voreinstellungen -> Preislisten ->
Preisliste für Tinte/Medien hinzufügen.

Resources
Druckerprofile, (benutzerdefinierte) Etiketten, Vorlagen,... werden von den RIPs über den
Lizenzserver hochgeladen und stehen in der Cloud zur Verfügung.

Support
❏ Download-Link zu den PrintFactory-Installationsprogrammen
❏ Erstellen einer Supportanfrage
❏ Treiberinformationen und Profil-Downloads
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